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BAB III 

METODE PENELITIAN 

3.1 Alur Penelitian 

Alur penelitian dalam penelitian ini dirancang untuk menunjukkan 

tahapan – tahapan sistematis yang dilakukan dalam proses pembuatan peta 

zona kerentanan gerakan tanah dengan mengombinasikan metode 

Frequency Ratio (FR) dan Logistic Regression (LR). Alur penelitian 

disusun secara terstruktur untuk menggambarkan setiap langkah penting 

yang dilalui, mulai dari tahap awal pengumpulan data spasial dan non – 

spasial, pemilihan dan pengolahan parameter – parameter penentu, hingga 

analisis statistik dan validasi model. Berikut disajikan diagram alir pada 

Gambar 3.1 

 

Gambar 3.1 Diagram Alir Penelitian 
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3.2 Software dan Tools 

Penelitian ini menggunakan software Sistem Informasi Geografis 

(SIG) dan statistik untuk mengolah serta menganalisis data spasial. Berikut 

merupakan software dan Tools yang digunakan dalam penelitian ini.  

1. ArcGIS versi 10.8 

Software ArcGIS 10.8 merupakan perangkat lunak utama yang 

digunakan dalam pengolahan data spasial. Beberapa Tools penting 

yang paling sering digunakan dalam penelitian ini yaitu : 

- Subset Features digunakan untuk membagi data titik gerakan tanah 

menjadi dua kategori, yaitu data latih (training) dan data validasi 

(testing). 

- Surface digunakan untuk menghasilkan peta Slope, aspek lereng, 

elevasi, dan Curvature dari data DEM. 

- Raster Calculator digunakan untuk melakukan operasi matematis 

antar Layer raster, seperti menghitung NDVI, nilai Z Logistic 

Regression, serta perhitungan matematis lainnya. 

- Mosaic To New Raster digunakan untuk menggabungkan beberapa 

Layer raster menjadi satu Layer raster baru, terutama saat data DEM 

atau citra yang diperoleh terdiri dari lebih dari satu tile. 

- Reclassify digunakan untuk mengelompokkan nilai-nilai raster ke 

dalam kelas atau kategori tertentu berdasarkan rentang nilai yang 

ditentukan. 

- Euclidean Distance digunakan untuk menghitung jarak setiap piksel 

terhadap fitur terdekat, seperti sungai dan jalan yang kemudian 

dihasilkan dalam bentuk peta raster jarak. 

- Extract by Mask digunakan untuk memotong data raster sesuai 

dengan batas administrasi wilayah penelitian, sehingga hanya area 

yang relevan yang dianalisis lebih lanjut. 
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- Resample digunakan untuk menyamakan resolusi spasial seluruh 

Layer raster agar memiliki cell size sebesar 10 untuk konsistensi 

dalam analisis spasial. 

- Lookup digunakan untuk menggabungkan nilai FR ke raster 

parameter berdasarkan atribut tertentu, sehingga setiap kelas raster 

dapat terhubung ke nilai bobotnya. 

- Conversion Tools seperti Polygon to Raster, Raster to ASCII, dan 

Point to Raster digunakan untuk mengonversi format data antara 

vektor, raster, dan ASCII, tergantung kebutuhan analisis. 

- 3D Analyst Tools dengan metode Inverse Distance Weighting (IDW) 

digunakan untuk mengolah data curah hujan menjadi peta distribusi 

spasial berdasarkan titik pengamatan. 

- Project Raster digunakan untuk menyelaraskan sistem koordinat data 

raster ke sistem proyeksi WGS UTM Zone 47N agar seluruh data 

memiliki referensi spasial yang sama. 

- Fill digunakan untuk mengisi kekosongan nilai (sink) pada permukaan 

DEM, sehingga menghasilkan permukaan topografi yang lebih halus 

dan bebas dari depresi tiruan. 

- Erase digunakan untuk menghilangkan bagian data yang berada di 

luar batas administrasi penelitian.  

- Merge digunakan untuk menggabungkan dua Layer shapefile menjadi 

satu Layer baru, seperti ketika menggabungkan hasil Erase dengan 

peta asli jenis tanah. 

- Multipart to Singlepart digunakan untuk memecah objek polygon 

yang kompleks (multipart) menjadi objek polygon tunggal 

(singlepart), sehingga setiap fitur dapat dianalisis secara lebih rinci. 

- Clip juga digunakan sebagai alternatif atau pelengkap Extract by Mask 

dalam proses pemotongan data raster atau vektor agar hanya 

mencakup wilayah penelitian. 
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2. IBM SPSS Statistics 

Analisis statistik dilakukan menggunakan IBM SPSS 

Statistics, khususnya untuk metode Binary Logistic Regression. 

Analisis ini digunakan untuk memodelkan hubungan antara parameter 

– parameter independen dengan variabel dependen berupa kejadian 

gerakan tanah (1 = terjadi, 0 = tidak terjadi). Fitur yang digunakan 

adalah Analyze > Regression > Binary Logistic dengan metode 

pemilihan variabel Forward: LR. Analisis dilakukan terhadap data 

pelatihan (train set) untuk menghasilkan nilai koefisien β dari masing-

masing parameter terpilih. Selain untuk pemodelan, IBM SPSS 

digunakan untuk menghasilkan Receiver Operating Characteristic 

(ROC) dan menghitung nilai Area Under Curve (AUC).  

3. Microsoft Excel 

Microsoft Excel digunakan sebagai media tabulasi dan penyusunan 

data sebelum diintegrasikan ke perangkat lunak lainnya. Di dalam 

Excel, dihitung rasio antara jumlah piksel kejadian gerakan tanah 

dengan jumlah total piksel dalam setiap kelas parameter. Selain itu, 

Excel juga dimanfaatkan dalam menghitung nilai Area Under Curve 

(AUC) untuk masing – masing parameter. 

3.3 Pengumpulan Data 

Penelitian ini menggunakan berbagai jenis data yang dikumpulkan 

dari lembaga-lembaga resmi untuk mendukung analisis parameter-

parameter yang berpengaruh terhadap kejadian gerakan tanah di Kabupaten 

Aceh Barat. Masing-masing data diperoleh melalui tahapan pengumpulan 

yang berbeda, sesuai dengan karakteristik dan jenisnya. Penjelasan 

mengenai sumber dan metode pengambilan tiap data disampaikan pada 

bagian berikut, sedangkan ilustrasi berupa gambar pengumpulan data dapat 

dilihat pada Lampiran 1. 



39 

 

 
Annisya Salsabila Handoko, 2025 
PEMETAAN ZONA KERENTANAN GERAKAN TANAH MENGGUNAKAN KOMBINASI METODE 
FREQUENCY RATIO DAN LOGISTIC REGRESSION DI KABUPATEN ACEH BARAT PROVINSI ACEH 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

 
 

3.3.1 Data Titik Gerakan Tanah 

Data utama yang digunakan dalam penelitian ini adalah data 

inventarisasi kejadian gerakan tanah sebanyak 448 titik yang diperoleh 

secara langsung dari Badan Geologi, Kementerian Energi dan Sumber Daya 

Mineral. Data ini memuat informasi mengenai lokasi-lokasi spesifik 

kejadian gerakan tanah yang telah terjadi di masa lalu dan digunakan 

sebagai dasar dalam pemodelan serta validasi kerentanan. Sebaran titik 

gerakan tanah tersebut ditampilkan pada Gambar 3.2. 

 

Gambar 3.2 Sebaran Titik Gerakan Tanah pada Wilayah Administrasi 

Kabupaten Aceh Barat 

Gambar 3.2 di atas menampilkan distribusi titik – titik gerakan tanah 

di Kabupaten Aceh Barat berdasarkan data dari Badan Geologi, 

Kementerian Energi dan Sumber Daya Mineral. Sebaran ini menjadi dasar 

dalam analisis spasial untuk menentukan keterkaitan antara kejadian 

gerakan tanah dengan berbagai parameter penyebab gerakan tanah. 



40 

 

 
Annisya Salsabila Handoko, 2025 
PEMETAAN ZONA KERENTANAN GERAKAN TANAH MENGGUNAKAN KOMBINASI METODE 
FREQUENCY RATIO DAN LOGISTIC REGRESSION DI KABUPATEN ACEH BARAT PROVINSI ACEH 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

 
 

3.3.2 Data Digital Elevation Model (DEM) 

Informasi topografi yang meliputi elevasi, kemiringan lereng 

(slope), aspek lereng, dan kelengkungan lereng (curvature). Data topografi 

tersebut diperoleh dari peta Digital Elevation Model Nasional (DEMNAS) 

yang disediakan oleh Badan Informasi Geospasial (BIG) melalui Portal 

Tanah Air Indonesia. DEMNAS dipilih karena memiliki cakupan nasional 

dengan resolusi yang cukup baik, sehingga dapat menggambarkan variasi 

bentuk permukaan lahan di wilayah penelitian secara detail. Data yang 

diunduh tersedia dalam format raster dan selanjutnya digunakan sebagai 

dasar untuk menurunkan berbagai parameter turunan topografi melalui 

proses analisis spasial. Portal Tanah Air Indonesia yang menjadi sumber 

data ditampilkan pada Gambar 3.3. 

 

Gambar 3.3 Tampilan grid pengunduhan data Digital Elevation Model 

(DEM)  

(Sumber : https://tanahair.indonesia.go.id/portal-web/unduh/demnas. 

Diakses pada : 22 April 2025) 

Data DEM diunduh berdasarkan tile–tile yang mencakup wilayah 

administrasi Kabupaten Aceh Barat. Proses pengunduhan dilakukan dengan 

memperhatikan cakupan spasial agar seluruh wilayah administratif 

Kabupaten Aceh Barat terwakili secara menyeluruh tanpa adanya celah 

data. Dalam penelitian ini, sebanyak 12 tile DEM diunduh untuk mewakili 

https://tanahair.indonesia.go.id/portal-web/unduh/demnas
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seluruh area penelitian. Data tersebut diperoleh dalam format raster (.tif) 

yang selanjutnya digunakan sebagai dasar untuk menghasilkan parameter 

topografi seperti elevasi, Slope, aspek lereng, dan Curvature.  

3.3.3 Data Tata Guna Lahan, Jarak dari Sungai, dan Jarak dari Jalan 

Informasi mengenai tata guna lahan (land use), jarak dari sungai, dan 

jarak dari jalan diambil dari peta Rupa Bumi Indonesia (RBI) yang juga 

bersumber dari Badan Informasi Geospasial (BIG) melalui Portal Tanah Air 

Indonesia. Data ini dimanfaatkan untuk mengetahui pengaruh aktivitas 

manusia dan tata ruang terhadap tingkat kerentanan gerakan tanah di 

wilayah Kabupaten Aceh Barat. 

 

Gambar 3.4 Tampilan Rupa Bumi Indonesia Pengunduhan Data Tata Guna 

Lahan, Jarak dari Sungai, dan Jarak dari Jalan 

(Sumber : https://tanahair.indonesia.go.id/portal-web/unduh/rbi-wilayah. 

Diakses pada : 22 April 2025) 

Pada Gambar 3.4, proses pengunduhan data RBI menyediakan dua 

pilihan resolusi, yaitu skala 1:25.000 dan 1:50.000. Dalam penelitian ini 

dipilih skala 1:50.000 karena cakupannya dianggap lebih representatif 

terhadap kebutuhan spasial di Kabupaten Aceh Barat, serta mampu 

memberikan keseimbangan antara ketelitian data dan luas area yang 

dianalisis. Data RBI yang diunduh disajikan dalam format kompresi (.zip) 

dan di dalamnya telah tersedia berbagai layer dalam bentuk shapefile, antara 

https://tanahair.indonesia.go.id/portal-web/unduh/rbi-wilayah
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lain jaringan jalan, jaringan sungai, batas administrasi, serta informasi 

penutup lahan. Keberagaman layer tersebut sangat penting karena menjadi 

sumber utama dalam penyusunan parameter penelitian yang berkaitan 

dengan kondisi fisik dan lingkungan wilayah penelitian. 

3.3.4 Data Litologi 

Data litologi diperoleh dari Peta Geologi lembar Aceh Barat yang 

bersumber dari Geomap milik Pusat Survei Geologi dapat dilihat pada 

Gambar 3.5. Peta ini dipilih karena cakupannya sesuai dengan batas 

administrasi Kabupaten Aceh Barat sehingga mampu merepresentasikan 

kondisi geologi di wilayah penelitian secara akurat. Peta ini diunduh 

berdasarkan lembar peta yang mencakup wilayah administrasi Kabupaten 

Aceh Barat. Proses pengunduhan dilakukan dengan memilih lembar peta 

yang relevan, kemudian data disimpan dalam format digital yang siap 

digunakan untuk analisis spasial. 

 

Gambar 3.5 Tampilan Geomap Pengunduhan Data Litologi  

(Sumber : https://geologi.esdm.go.id/geomap/pages/district/11.05.  

Diakses pada : 4 Maret 2025) 

Pada Gambar 3.5 ditampilkan proses pengunduhan data litologi 

yang digunakan dalam penelitian ini. Data tersebut diperoleh dari Peta 

Geologi Indonesia skala 1:100.000 yang tersedia melalui portal GeoMap 

milik Pusat Survei Geologi, Badan Geologi. Data diunduh dalam format 

https://geologi.esdm.go.id/geomap/pages/district/11.05
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shapefile (.shp) yang memuat informasi spasial mengenai sebaran satuan 

batuan di wilayah Kabupaten Aceh Barat.  

3.3.5 Data Jenis Tanah 

Data jenis tanah diperoleh dari Badan Perencanaan Pembangunan 

Daerah (Bappeda) Aceh. Data ini memuat informasi mengenai klasifikasi 

jenis tanah di Kabupaten Aceh Barat. Data tersebut diperoleh dalam format 

shapefile (.shp) yang disajikan pada Gambar 3.6 berikut.  

 

Gambar 3.6 Tampilan Data Jenis Tanah dari Bappeda Aceh 

3.3.6 Data Peak Ground Acceleration (PGA) 

Data Peak Ground Acceleration (PGA) diperoleh dari Badan 

Geologi yang memuat informasi mengenai distribusi nilai percepatan tanah 

maksimum yang diperkirakan dapat terjadi akibat aktivitas seismik di 

wilayah Kabupaten Aceh Barat. Data disediakan dalam format raster (.tif) 

dan ditampilkan pada Gambar 3.7. 

 

Gambar 3.7 Tampilan Data PGA dari Badan Geologi 
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3.3.7 Data Normalized Difference Vegetation Index (NDVI) 

Data vegetasi diperoleh dari citra satelit Landsat 8 Sentinel – 2 yang 

diunduh melalui situs resmi Copernicus Data Space Ecosystem. Citra ini 

digunakan untuk menghitung Normalized Difference Vegetation Index 

(NDVI) sebagai representasi tingkat kerapatan vegetasi pada permukaan 

lahan di wilayah Kabupaten Aceh Barat. 

 

Gambar 3.8 Laman Pengambilan Data citra Sentinel – 2 melalui 

Copernicus Data Space Ecosystem 

(Sumber : https://browser.dataspace.copernicus.eu/. Diakses pada : 22 

April 2025) 

Tahapan dalam proses pengunduhan citra melalui portal Copernicus 

Data Space Ecosystem dilakukan untuk memperoleh data yang sesuai 

dengan wilayah penelitian. Langkah pertama yaitu pencarian lokasi 

Kabupaten Aceh Barat menggunakan fitur pencarian. Pembuatan Area of 

Interest (AOI) berbentuk persegi panjang yang mencakup seluruh wilayah 

studi dilakukan sebagaimana ditunjukkan pada Gambar 3.8 di atas.  

Selanjutnya, menu pencarian (Search) diatur dengan memilih 

sumber data Sentinel-2 dengan sensor MSI. Tahap ini dilakukan dengan 

menetapkan batas tutupan awan serendah mungkin untuk memperoleh citra 

yang bersih serta menentukan rentang waktu akuisisi data. Setelah hasil 

pencarian ditampilkan, Band 8 (Near Infrared/NIR) dan Band 4 (Red) 

https://browser.dataspace.copernicus.eu/
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dipilih untuk diunduh karena kedua band tersebut digunakan dalam 

perhitungan Normalized Difference Vegetation Index (NDVI). 

3.3.8 Data Curah Hujan 

Data curah hujan diperoleh dari basis data Climate Hazards Group 

Infrared Precipitation with Station (CHIRPS). Data ini memberikan 

informasi spasial dan temporal mengenai distribusi curah hujan yang dapat 

memicu terjadinya gerakan tanah, terutama pada wilayah dengan curah 

hujan tinggi atau intensitas hujan yang ekstrem. Tampilan laman unduhan 

CHIRPS ditunjukkan pada Gambar 3.9 berikut. 

 

Gambar 3.9 Laman Pengunduhan Data Curah Hujan melalui Portal 

CHIRPS 

(Sumber : https://data.chc.ucsb.edu/products/CHIRPS-

2.0/indonesia_monthly/bils/. Diakses pada : 22 April 2025) 

Gambar 3.9 memperlihatkan tampilan portal CHIRPS yang 

digunakan untuk memperoleh data curah hujan di wilayah Indonesia. Data 

yang diunduh dipilih dalam bentuk data bulanan dengan rentang waktu 

tahun 2005 hingga 2025 yang selanjutnya digunakan untuk menghitung rata 

– rata curah hujan tahunan di wilayah Kabupaten Aceh Barat. Pemilihan 

data dari portal CHIRPS didasarkan pada ketersediaan jangka waktu yang 

panjang dan cakupan spasial yang luas. 

https://data.chc.ucsb.edu/products/CHIRPS-2.0/indonesia_monthly/bils/
https://data.chc.ucsb.edu/products/CHIRPS-2.0/indonesia_monthly/bils/
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3.4 Pengolahan Data Parameter 

Pengolahan data parameter dilakukan sebagai tahap lanjutan setelah 

proses pengumpulan data. Setiap parameter yang digunakan dalam analisis 

kerentanan gerakan tanah diproses sesuai dengan karakteristik dan jenis 

datanya masing-masing. Seluruh layer raster parameter disesuaikan agar 

memiliki resolusi spasial (cell size) yang seragam yaitu 10 meter serta 

jumlah piksel yang sama. Selain itu, semua data diproyeksikan ke sistem 

koordinat WGS 1984 UTM Zone 47N agar berada dalam referensi spasial 

sesuai dengan zona waktu Kabupaten Aceh Barat. Tahapan pengolahan 

meliputi pemotongan wilayah, konversi format data, serta klasifikasi ke 

dalam beberapa kelas tertentu sesuai kebutuhan setiap parameter. 

Penjelasan rinci mengenai proses pengolahan masing-masing parameter 

disampaikan pada bagian berikut, sedangkan ilustrasi berupa gambar 

tahapan pengolahan data dapat dilihat pada Lampiran 2. 

3.4.1 Titik Gerakan Tanah 

Titik gerakan tanah yang telah diunduh dibagi menjadi dua dataset, 

yaitu data pelatihan (training) sebesar 80% dan data validasi (testing) 

sebesar 20%. Pembagian dilakukan secara acak menggunakan Tool Subset 

Features pada perangkat lunak ArcGIS, sehingga distribusi data pelatihan 

dan data validasi merata. Pada proses ini, input features berupa layer seluruh 

titik gerakan tanah, kemudian direktori dan nama file ditentukan untuk 

output training feature class yang menampung 80% titik, serta output test 

feature class yang menampung 20% sisanya. Parameter size of training 

feature subset diisi dengan nilai 80, dengan satuan percentage of input yang 

menandakan bahwa 80% dari total titik digunakan sebagai data pelatihan, 

sedangkan sisanya sebagai data validasi. 

Gambar 3.10 menampilkan sebaran titik gerakan tanah hasil 

pembagian data pelatihan (train) dan data validasi (test). Data pelatihan 

digunakan untuk membangun dan melatih model agar dapat mengenali pola 

hubungan antara parameter penyebab dengan kejadian longsor. Sementara 
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itu, data validasi berfungsi untuk menguji kinerja model secara independen 

sehingga hasil yang diperoleh tidak hanya sesuai dengan data latih, tetapi 

juga mampu memprediksi kejadian pada data baru. 

 

Gambar 3.10 Sebaran Titik Gerakan Tanah Hasil Pembagian Data 

Pelatihan (train) dan Data Validasi (test) 

Rincian jumlah titik pada masing – masing dataset hasil pembagian 

menggunakan Tool Subset Features dapat dilihat pada Tabel 3.1 berikut. 

Tabel 3.1 Jumlah Titik Gerakan Tanah pada Setiap Dataset 

 

 

 

Setelah pembagian dataset, data pelatihan dan data validasi masing-

masing dikonversi ke format raster menggunakan Tool Point to Raster. 

Konversi ini dilakukan agar data titik dapat diproses bersama dengan layer 

parameter lain yang berbentuk raster. Selanjutnya, data raster hasil konversi 

diolah menggunakan Tool Raster Calculator untuk menghasilkan raster 

Dataset Jumlah Titik Gerakan Tanah 

Data Pelatihan (train) 358 

Data Validasi (test) 90 
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boolean. Pada raster boolean ini, piksel yang merepresentasikan titik 

gerakan tanah bernilai 1, sedangkan piksel lainnya menjadi NoData. Raster 

boolean tersebut berfungsi sebagai masking layer yang hanya menampilkan 

nilai pada lokasi titik pelatihan dan digunakan untuk mengekstrak nilai 

parameter pada tahap analisis spasial berikutnya. 

3.4.2 Parameter Elevasi, Kemiringan Lereng (Slope), Aspek Lereng, dan 

Kelengkungan (Curvature) 

Data Digital Elevation Model (DEM) yang digunakan terdiri dari 12 

tile raster yang mencakup seluruh wilayah Kabupaten Aceh Barat. Seluruh 

tile digabungkan menjadi satu raster utuh menggunakan Tool Mosaic To 

New Raster pada ArcGIS agar lebih mudah diolah pada tahap selanjutnya. 

Resolusi spasial ditetapkan sebesar 10 meter untuk menjaga konsistensi 

dengan parameter lain, sedangkan tipe piksel diatur sebagai 

32_BIT_FLOAT agar nilai elevasi tersimpan secara presisi. Raster hasil 

mosaik kemudian dipotong sesuai batas administrasi Kabupaten Aceh Barat 

menggunakan Tool Extract by Mask.  

3.4.2.1 Parameter Elevasi  

Data DEM yang telah dipotong sesuai batas wilayah kemudian 

diklasifikasi menggunakan Tool Reclassify. Proses klasifikasi ini dilakukan 

untuk mengelompokkan nilai elevasi ke dalam kelas-kelas tertentu sehingga 

distribusi ketinggian wilayah dapat dipetakan secara lebih terstruktur dan 

mudah dianalisis. Dengan adanya pengelompokan kelas, pola keragaman 

elevasi dapat terlihat jelas serta mempermudah dalam menghubungkan 

kondisi topografi dengan faktor kerentanan gerakan tanah.  

Dalam penelitian ini digunakan metode Defined Interval, yaitu 

metode yang membagi rentang nilai elevasi ke dalam interval yang sama 

besar. Metode Defined Interval digunakan untuk membagi elevasi menjadi 

10 kelas dengan interval sekitar 175 meter. Pengaturan batas kelas dilakukan 

langsung pada kolom Break Values di jendela Reclassify sehingga 
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penentuan interval sesuai dengan kebutuhan analisis. Hasil reclassify ini 

kemudian menjadi dasar untuk tahap analisis berikutnya, terutama dalam 

mengidentifikasi hubungan antara kelas elevasi dengan distribusi kejadian 

gerakan tanah di Kabupaten Aceh Barat.  

Menurut Sinčić dkk. (2025), klasifikasi elevasi ke dalam 10 kelas 

diketahui memberikan performa model yang stabil dan akurat, namun pada 

penelitian ini interval kelas dimodifikasi agar sesuai dengan kondisi wilayah 

penelitian. Klasifikasi elevasi ditampilkan pada Tabel 3.2. 

Tabel 3.2 Klasifikasi Parameter Elevasi 

No. Elevasi (m) 

1. 0 ≤ x < 175 

2. 175 ≤ x < 350 

3. 350 ≤ x < 525 

4. 525 ≤ x < 700 

5. 700 ≤ x < 875 

6. 875 ≤ x < 1050 

7. 1050 ≤ x < 1225 

8. 1225 ≤ x <1400 

9. 1400 ≤ x <1575 

10. x ≥ 1575 

 

3.4.2.2 Parameter Kemiringan Lereng (Slope) 

Parameter kemiringan lereng (slope) diperoleh menggunakan Tool 

Slope pada menu Surface yang menghitung tingkat kecuraman wilayah 

dalam satuan derajat. Klasifikasi lereng mengacu pada Van Zuidam (1985) 

yang membagi lereng ke dalam tujuh kelas, yaitu datar, sangat landai, 

landai, agak curam, curam, sangat curam, dan terjal. Pengelompokan nilai 

dilakukan melalui menu Classify pada jendela Reclassify dengan penetapan 

batas kelas pada kolom Break Values.  
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3.4.2.3 Parameter Aspek Lereng 

Parameter aspek lereng diolah menggunakan Tool Aspect dalam 

Surface berdasarkan data DEM yang sama. Pada tahapan ini, raster hasil 

pembuatan peta aspek lereng diklasifikasikan ke dalam 10 kelas dengan 

metode klasifikasi Natural Breaks (Jenks). Pengelompokan nilai dilakukan 

melalui menu Classify pada jendela Reclassify. Klasifikasi parameter aspek 

lereng disajikan pada Tabel 3.3 berikut. 

Tabel 3.3 Klasifikasi Parameter Aspek Lereng 

No. Aspek Lereng (o) Klasifikasi 

1. -1 ≤ x < 0 Datar 

2. 0 ≤ x < 22,5 Utara 

3. 22,5 ≤ x < 67,5 Timur Laut 

4. 67,5 ≤ x < 112,5 Timur 

5. 112,5 ≤ x < 157,5 Tenggara 

6. 157,5 ≤ x < 202,5 Selatan 

7. 202,5 ≤ x < 247,5 Barat Daya 

8. 247,5 ≤ x < 292,5 Barat 

9. 292,5 ≤ x < 337,5 Barat Laut 

10. 337,5 ≤ x < 360 Utara 

 

3.4.2.4 Parameter Kelengkungan Lereng (Curvature) 

Parameter kelengkungan lereng (curvature) diperoleh menggunakan 

Tool Curvature pada menu Surface yang menghasilkan dua output raster, 

yaitu profile curvature dan plan curvature. Profile curvature 

menggambarkan kelengkungan permukaan pada arah vertikal (searah 

aliran) yang memengaruhi percepatan atau perlambatan aliran air, 

sedangkan plan curvature menunjukkan kelengkungan permukaan secara 

horizontal (tegak lurus aliran) yang memengaruhi arah penyebaran aliran 

air. Menurut Gholami dkk. (2019), kedua parameter ini diklasifikasikan 

menjadi tiga kategori, yaitu cekung (concave) dengan nilai negatif, 
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cembung (convex) dengan nilai positif, dan datar (flat) dengan nilai 

mendekati nol.  

Klasifikasi tersebut memudahkan dalam interpretasi bentuk 

permukaan lereng, di mana lereng cekung cenderung mengumpulkan aliran 

air sehingga berpotensi meningkatkan kejenuhan tanah, lereng cembung 

lebih rentan terhadap pelepasan material karena konsentrasi gaya gravitasi, 

sedangkan kondisi datar relatif lebih stabil karena tidak banyak 

memengaruhi pergerakan aliran permukaan. Hasil klasifikasi menghasilkan 

raster baru untuk profile curvature dan plan curvature yang masing-masing 

ditampilkan pada Tabel 3.4 dan Tabel 3.5.  

Tabel 3.4 Klasifikasi Parameter Profile Curvature 

No. Profile Curvature (o) Klasifikasi 

1. -111,50 ≤ x < -33,03 Concave 

2. -33,03 ≤ x < 45,42 Flat 

3. 45,42 ≤ x < 123,89 Convex 

 

Tabel 3.5 Klasifikasi Parameter Plan Curvature 

No. Plan Curvature (o) Klasifikasi 

1. -56,48 ≤ x < -0,99 Concave 

2. -0,99 ≤ x < 0,44 Flat 

3. 0,44 ≤ x < 84,15 Convex 

3.4.3 Parameter Tata Guna Lahan, Jarak dari Sungai, dan Jarak dari 

Jalan 

Setelah file kompresi (.zip) data Rupa Bumi Indonesia (RBI) 

diekstrak, diperoleh sejumlah Layer shapefile yang merepresentasikan 

berbagai elemen geografis di wilayah penelitian. Layer – layer tersebut 

kemudian dipilih dan diproses sesuai dengan parameter yang dibutuhkan, 

yaitu tata guna lahan, jarak dari sungai, dan jarak dari jalan, sebelum 

dilakukan pengolahan lebih lanjut dalam bentuk raster.  
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3.4.3.1 Parameter Tata Guna Lahan 

Parameter tata guna lahan diperoleh dari peta RBI yang terlebih 

dahulu dipotong sesuai batas administrasi wilayah penelitian. Data ini 

mencakup berbagai klasifikasi penggunaan lahan, seperti permukiman, 

hutan, sawah, dan semak belukar. Peta hasil pemotongan masih berbentuk 

poligon (.shp), sehingga dikonversi menjadi raster menggunakan Tool 

Polygon to Raster. Hasil klasifikasi tata guna lahan ditampilkan pada Tabel 

3.6. 

Tabel 3.6 Klasifikasi Parameter Tata Guna Lahan 

No.  Klasifikasi  

1. Pasir / Bukit Pasir Darat 

2. Perkebunan / Kebun 

3. Tegalan / Ladang 

4. Sawah 

5. Danau / Situ 

6. Empang 

7. Tanah Kosong / Gundul 

8. Hutan Rimba 

9. Semak Belukar 

10. Rawa 

11. Sungai 

12. Tambak 

13. Permukiman dan Tempat Kegiatan 

3.4.3.2 Parameter Jarak dari Jalan 

Parameter jarak dari jalan diperoleh dengan memotong jaringan 

jalan menggunakan Tool Clip sesuai batas administrasi Kabupaten Aceh 

Barat, kemudian diproyeksikan ke zona WGS UTM 47N. Jarak tiap lokasi 

terhadap jalan terdekat dihitung menggunakan Tool Euclidean Distance, 

lalu hasilnya diklasifikasikan ke dalam 10 kelas dengan interval 2.500 meter 

menggunakan Tool Reclassify dan metode Defined Interval.  
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Proses klasikasi ini menghasilkan peta raster yang menunjukkan 

nilai jarak dari setiap titik di wilayah penelitian terhadap jaringan jalan 

terdekat. Nilai jarak tersebut kemudian diklasifikasikan ke dalam 10 kelas 

dengan interval 2.500 meter menggunakan Tool Reclassify dengan metode 

Defined Interval. Menurut Tehrany dkk. (2019), klasifikasi jarak dari jalan 

ke dalam 10 kelas dapat meningkatkan akurasi model, namun pada 

penelitian ini rentang kelas dimodifikasi agar sesuai dengan kondisi wilayah 

penelitian. Hasil klasifikasi jarak dari jalan ditampilkan pada Tabel 3.7. 

Tabel 3.7 Klasifikasi Parameter Jarak dari Jalan 

No. Jarak dari Jalan (m) 

1. 0 ≤ x < 2500 

2. 2500 ≤ x < 5000 

3. 5000 ≤ x < 7500 

4. 7500 ≤ x < 10000 

5. 10000 ≤ x < 12500 

6. 12500 ≤ x < 15000 

7. 15000 ≤ x < 17500 

8. 17500 ≤ x < 20000 

9. 20000 ≤ x < 22500 

10. x ≥ 22500 

 

3.4.3.3 Parameter Jarak dari Sungai 

Parameter jarak dari sungai diperoleh dengan memotong jaringan 

sungai menggunakan Tool Clip sesuai batas administrasi Kabupaten Aceh 

Barat, kemudian diproyeksikan ke zona WGS UTM 47N. Jarak tiap lokasi 

terhadap sungai terdekat dihitung menggunakan Tool Euclidean Distance, 

lalu hasilnya diklasifikasikan ke dalam 10 kelas dengan interval 1.600 meter 

menggunakan Tool Reclassify dan metode Defined Interval.  

Proses klasikasi ini menghasilkan peta raster yang menunjukkan 

nilai jarak dari setiap titik di wilayah penelitian terhadap sungai terdekat. 
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Nilai jarak tersebut kemudian diklasifikasikan ke dalam 10 kelas dengan 

interval 1.600 meter menggunakan Tool Reclassify dengan metode Defined 

Interval. Menurut Tehrany dkk. (2019), klasifikasi jarak dari sungai ke 

dalam 10 kelas dianggap dapat merepresentasikan variasi spasial secara 

lebih proporsional, namun pada penelitian ini rentang kelas dimodifikasi 

agar sesuai dengan kondisi wilayah studi. Hasil klasifikasi jarak dari sungai 

ditampilkan pada Tabel 3.8. 

Tabel 3.8 Klasifikasi Parameter Jarak dari Sungai 

No. Jarak dari Sungai (m) 

1. 0 ≤ x < 1600 

2. 1600 ≤ x < 3200 

3. 3200 ≤ x < 4800 

4. 4800 ≤ x < 6400 

5. 6400 ≤ x < 8000 

6. 8000 ≤ x < 9600 

7. 9600 ≤ x < 11200 

8. 11200 ≤ x < 12800 

9. 12800 ≤ x < 14400 

10. x ≥ 14400 

3.4.4 Parameter Jenis Tanah  

Parameter jenis tanah diperoleh dari data Badan Perencanaan 

Pembangunan Daerah (Bappeda) Aceh yang sudah tersedia dalam format 

raster, sehingga tidak diperlukan proses konversi dari poligon. Data ini 

terlebih dahulu disesuaikan dengan batas administrasi Kabupaten Aceh 

Barat serta diproyeksikan ke sistem koordinat WGS UTM Zone 47N 

menggunakan Tool Project agar konsisten dengan data lain. Selanjutnya, 

proses pengolahan dilakukan dengan Tool Erase dan Tool Merge untuk 

memastikan cakupan wilayah sesuai dengan area penelitian.  
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Tahap berikutnya menggunakan Tool Multipart to Singlepart untuk 

memisahkan poligon majemuk menjadi poligon tunggal sehingga setiap unit 

spasial memiliki atribut sendiri. Kolom atribut “jenis_tanah” yang kosong 

kemudian dilengkapi secara manual dengan merujuk pada poligon terdekat 

melalui Identify Tool agar seluruh data bersifat lengkap dan konsisten. 

Setelah itu, Tool Clip digunakan untuk memotong data sesuai batas 

administrasi Kabupaten Aceh Barat sehingga area di luar wilayah penelitian 

dieliminasi. Hasil akhir peta kemudian diklasifikasikan berdasarkan kolom 

“jenis_tanah” yang ditampilkan pada Tabel 3.9. 

Tabel 3.9 Klasifikasi Parameter Jenis Tanah 

No. Jenis Tanah 

1. Distric Fluviol (Alluvial) 

2. Humic Acrisol (Podsolik) 

3. Humic Ferrasols 

3.4.5 Parameter Litologi  

Parameter litologi diperoleh dari Peta Geologi lembar Aceh Barat 

yang bersumber dari Geomap Pusat Survei Geologi dalam format shapefile 

(.shp). Peta ini menggambarkan sebaran satuan batuan sedimen, vulkanik, 

dan metamorf yang memiliki karakteristik berbeda dalam kaitannya dengan 

kestabilan lereng. Sebelum digunakan dalam analisis, data litologi terlebih 

dahulu diproyeksikan ke sistem koordinat WGS 1984 UTM Zone 47N 

menggunakan Tool Project untuk menyeragamkan sistem koordinat dengan 

data lainnya serta meminimalkan kesalahan spasial. Proses selanjutnya 

dilakukan dengan Tool Erase dan Tool Merge agar batas peta litologi sesuai 

dengan batas administrasi Kabupaten Aceh Barat, sehingga area analisis 

benar-benar mencerminkan kondisi geologi wilayah penelitian. Setelah itu, 

Tool Multipart to Singlepart digunakan untuk memisahkan poligon 

majemuk menjadi poligon tunggal. Langkah ini penting agar setiap unit 

poligon dapat dianalisis secara individual dan memiliki atribut tersendiri. 



56 

 

 
Annisya Salsabila Handoko, 2025 
PEMETAAN ZONA KERENTANAN GERAKAN TANAH MENGGUNAKAN KOMBINASI METODE 
FREQUENCY RATIO DAN LOGISTIC REGRESSION DI KABUPATEN ACEH BARAT PROVINSI ACEH 
Universitas Pendidikan Indonesia | repository.upi.edu | perpustakaan.upi.edu 

 
 

Dalam proses pemeriksaan atribut, ditemukan bahwa sebagian 

kolom atribut “REMARK” masih kosong. Untuk menjaga kelengkapan dan 

konsistensi data, kolom tersebut kemudian dilengkapi secara manual dengan 

merujuk pada poligon terdekat melalui Identify Tool. Langkah ini dilakukan 

secara teliti agar tidak terjadi kesalahan pengisian atribut yang dapat 

memengaruhi hasil analisis. Tahap akhir adalah pemotongan menggunakan 

Tool Clip sehingga peta litologi hanya mencakup wilayah penelitian sesuai 

dengan batas administrasi Kabupaten Aceh Barat. 

Dengan demikian, peta litologi yang dihasilkan telah siap digunakan 

sebagai salah satu parameter dalam analisis kerentanan gerakan tanah. 

Klasifikasi litologi selengkapnya dapat dilihat pada Tabel 3.10. 

Tabel 3.10 Klasifikasi Parameter Litologi 

No. Litologi 

1. Formasi Meulaboh 

2. Formasi Gunungapi Sapi 

3. Formasi Lampung 

4. Formasi Gunungapi Calang 

5. Formasi Geumpang 

6. Formasi Kueh 

7. Formasi Batugamping Teunom 

8. Formasi Gume 

9. Serpentinit 

10. Formasi Bale 

11. Alluvium 

12. Formasi Meucampli 

13. Formasi Tangla 

14. Formasi Baong 
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3.4.6 Parameter Peak Ground Acceleration (PGA) 

Pembuatan peta parameter PGA yaitu diawali dengan memotong 

peta hasil unduhan dari PVMBG sesuai dengan batas administrasi wilayah 

penelitian. Setelah itu, proses klasifikasi dilakukan dengan menggunakan 

metode klasifikasi Defined Interval dengan mengatur agar menjadi 4 kelas 

dalam interval 0,2 gal berdasarkan Tabel 2.4.  

3.4.7 Parameter NDVI 

Data citra satelit Sentinel-2 yang digunakan berasal dari portal 

Copernicus Data Space Ecosystem dan terdiri atas Band 8 (Near Infrared) 

serta Band 4 (Red). Kedua band dipotong menggunakan Tool Extract by 

Mask agar sesuai dengan batas administrasi Kabupaten Aceh Barat, 

kemudian dihitung nilai Normalized Difference Vegetation Index (NDVI) 

menggunakan Tool Raster Calculator berdasarkan persamaan 2.7. Hasil 

perhitungan menghasilkan peta NDVI yang merepresentasikan tingkat 

kerapatan vegetasi, dengan dua layer raster sesuai jumlah tile citra input.  

3.4.8 Parameter Curah Hujan 

Data curah hujan yang digunakan dalam penelitian ini berasal dari 

CHIRPS dengan skala bulanan selama periode 20 tahun, yaitu dari tahun 

2005 hingga 2025. Tahap pertama pengolahan dilakukan dengan 

menjumlahkan curah hujan bulanan (Januari–Desember) untuk masing-

masing tahun, sehingga diperoleh total curah hujan tahunan. Selanjutnya, 

seluruh data curah hujan tahunan selama periode 20 tahun tersebut dirata-

ratakan untuk mendapatkan distribusi curah hujan tahunan rata-rata di 

wilayah penelitian. 

Proses perhitungan spasial dilakukan menggunakan Tool Cell 

Statistics pada ArcGIS dengan fungsi Mean, sehingga nilai rata-rata 

dihitung pada posisi piksel yang sama dari setiap tahun. Hasil pengolahan 

ini berupa peta raster curah hujan rata-rata tahunan yang menggambarkan 

distribusi spasial intensitas hujan jangka panjang di Kabupaten Aceh Barat. 
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Untuk memastikan data hanya mencakup area relevan, tahap selanjutnya 

menggunakan Raster Calculator dengan fungsi SetNull untuk menyaring 

nilai-nilai di luar batas wilayah menjadi NoData. 

Kemudian, titik-titik sampel yang mewakili wilayah penelitian 

diolah menggunakan metode Inverse Distance Weighting (IDW) untuk 

menghasilkan peta distribusi curah hujan secara kontinu. Hasil interpolasi 

ini selanjutnya dipotong menggunakan Tool Extract by Mask berdasarkan 

batas administrasi Kabupaten Aceh Barat agar sesuai dengan wilayah 

penelitian. Tahap akhir pengolahan adalah klasifikasi nilai curah hujan ke 

dalam empat kelas menggunakan metode Defined Interval dengan interval 

500 mm/tahun.  

Melalui proses Reclassify, peta curah hujan dikategorikan secara 

sistematis ke dalam empat kelas interval yang telah ditentukan, sehingga 

perbedaan tingkat curah hujan di wilayah penelitian dapat diidentifikasi 

dengan jelas. Hasil akhir dari proses ini berupa peta curah hujan 

terklasifikasi dengan empat kelas interval yang telah ditentukan, yang 

selanjutnya disajikan secara detail pada Tabel 3.11. 

Tabel 3.11 Klasifikasi Parameter Curah Hujan 

No. Curah Hujan (mm/tahun) 

1. 0 ≤ x < 2500 

2. 2500 ≤ x < 3000 

3. 3000 ≤ x < 3500 

4. 3500 ≤ x < 4000 

 

3.5 Analisis Metode Frequency Ratio (FR) 

Analisis dilakukan dengan menggabungkan pengolahan spasial 

menggunakan ArcGIS dan analisis numerik melalui Microsoft Excel. Tahap 

awal melibatkan perkalian antara raster boolean kejadian gerakan tanah 

pelatihan (ls_trn.tif) dengan raster hasil klasifikasi tiap parameter 

menggunakan Raster Calculator. Hasilnya disimpan sebagai 
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ls_(parameter), misalnya ls_elevasi atau ls_slope. Perkalian ini bertujuan 

mempertahankan piksel dengan nilai 1 pada raster ls_trn.tif yang 

menunjukkan kejadian gerakan tanah, sedangkan piksel lainnya bernilai 0.  

Setelah itu diamati open attribute table untuk melihat distribusi 

piksel pada setiap kelas parameter. Tabel ini berisi dua kolom utama, yaitu 

Value (kelas parameter) dan Count (jumlah piksel kejadian). Perhitungan 

ini digunakan untuk mengukur peran tiap kelas parameter dalam terjadinya 

gerakan tanah. Nilai FR lebih besar dari 1 menunjukkan kontribusi di atas 

rata-rata, sedangkan nilai lebih kecil dari 1 menunjukkan kontribusi di 

bawah rata-rata. Walaupun FR bersifat statistik, penerapannya pada ArcGIS 

membutuhkan penyesuaian seperti konversi ke bilangan bulat agar sesuai 

dengan format raster.  

 Oleh karena itu, pada Excel dibuat lembar kerja baru bernama FR 

yang terdiri dari dua kolom: Class_ID dan x1000. Tabel ini digunakan untuk 

proses join ke layer raster parameter di ArcGIS karena hanya kolom ID dan 

bobot integer FR yang diperlukan. Tabel disimpan dalam format Microsoft 

Excel 97–2003 Worksheet (.xls). Tabel 3.13 menyajikan daftar kolom – 

kolom atribut yang diperlukan dalam proses join pada ArcGIS. 

Tabel 3.12 Tabel untuk Join di ArcGIS 

Class_ID x1000 

1 507 

2 1261 

3 2294 

4 1829 

5 2479 

6 902 

7 2317 

8 2009 

9 671 

10 2 
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Proses berikutnya adalah melakukan join antara raster parameter 

misalnya elevasi_cls, dengan tabel hasil perhitungan Frequency Ratio yang 

diperoleh dari Excel. Tahap ini bertujuan agar setiap kelas parameter 

memiliki nilai FR yang sesuai. Setelah proses join selesai, nilai bobot FR 

diterapkan pada setiap piksel parameter menggunakan Tool Lookup pada 

Spatial Analyst Tools. Raster input yang digunakan adalah hasil join, 

sedangkan field yang dipilih adalah x1000. Hasil dari tahapan ini disimpan 

dalam bentuk raster dengan nama fr_elevasi.tif. 

Nilai x1000 dikenali sebagai tipe data double sehingga raster yang 

dihasilkan tidak memiliki atribut tabel yang dapat digunakan untuk 

keperluan validasi model. Untuk mengatasi hal tersebut, raster fr_elevasi.tif 

kemudian dikonversi ke bilangan bulat dengan menggunakan fungsi Int() 

pada Raster Calculator. Rumus yang digunakan adalah Int("fr_elevasi.tif"), 

dan hasilnya disimpan dengan nama int_fr_elevasi.tif. 

Tahap selanjutnya yaitu melakukan validasi kontribusi parameter 

terhadap kejadian gerakan tanah menggunakan metode AUC. Validasi 

dilakukan dengan cara mengalikan raster int_fr_elevasi.tif dengan raster 

ls_trn.tif pada Raster Calculator sehingga diperoleh raster baru dengan 

nama auc_elevasi. Hasil perhitungan AUC kemudian direkap dalam file 

Excel, misalnya elevasi_auc.xlsx. Parameter dianggap memiliki kontribusi 

tinggi apabila nilai AUC yang diperoleh mencapai atau melebihi 0,6. 

Seluruh rangkaian proses ini diterapkan secara berulang untuk parameter 

lainnya seperti kemiringan lereng, aspek lereng, litologi, tata guna lahan, 

curah hujan, dan sebagainya. 

Setelah semua parameter yang memenuhi kriteria AUC ≥ 0,6 

dianalisis menggunakan metode Frequency Ratio, tahap berikutnya yaitu 

penyusunan peta indeks kerentanan gerakan tanah atau Landslide 

Susceptibility Index (LSI). Proses ini dilakukan di ArcGIS dengan 

menjumlahkan seluruh raster parameter dominan yang telah diberikan nilai 

menggunakan nilai Frequency Ratio melalui Tool Raster Calculator. Hasil 
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penjumlahan tersebut menghasilkan peta LSI berbasis metode Frequency 

Ratio yang menggambarkan tingkat kerentanan gerakan tanah secara 

spasial. Selanjutnya, nilai-nilai pada peta LSI diklasifikasikan ke dalam 

beberapa kelas kerentanan menggunakan metode Natural Breaks (Jenks) 

melalui Tool Reclassify. 

3.5.1 Validasi Model AUC Metode Frequency Ratio 

Untuk melakukan validasi model, peta Landslide Susceptibility 

Index (LSI) hasil pengolahan parameter dominan berbobot Frequency Ratio 

terlebih dahulu dikonversi ke format ASCII menggunakan Tool Raster to 

ASCII pada ArcGIS. Proses konversi serupa juga dilakukan terhadap data 

raster kejadian gerakan tanah pelatihan (ls_trn) dan pengujian (ls_tst). 

Seluruh data dalam format ASCII kemudian diimpor ke perangkat lunak 

IBM SPSS Statistics untuk keperluan analisis validasi. Pada tahap ini, file 

ls_trn digunakan dalam perhitungan success rate, sedangkan file ls_tst 

digunakan untuk perhitungan prediction rate. 

Setelah data berhasil diimpor ke SPSS, setiap kolom diberi nama, 

misalnya FR_N untuk mewakili nilai indeks kerentanan pada tiap piksel. 

Analisis dilakukan menggunakan metode Receiver Operating 

Characteristic (ROC) melalui menu Analyze > Classify > ROC Curve. Pada 

jendela pengaturan, kolom FR_N dimasukkan sebagai Test Variable, 

sedangkan kolom trn atau tst digunakan sebagai State Variable. Nilai State 

Value diisi dengan angka 1 karena angka ini merepresentasikan keberadaan 

kejadian gerakan tanah. Selanjutnya, opsi ROC Curve dan With Diagonal 

Reference Line dicentang untuk menampilkan kurva ROC lengkap dengan 

garis referensi diagonal sebagai pembanding terhadap model acak. 

3.6 Analisis Metode Logistic Regression (LR) 

Metode Logistic Regression (LR) digunakan untuk menyusun model 

prediksi kerentanan gerakan tanah dengan mempertimbangkan parameter 

dominan yang sebelumnya teridentifikasi melalui analisis Frequency Ratio 
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(AUC ≥ 0,6). Metode ini dipilih karena mampu menangani hubungan 

nonlinier antara variabel dependen (kejadian gerakan tanah) dan variabel 

independen (faktor spasial/fisik), serta menghasilkan model prediktif yang 

dapat diterapkan pada seluruh area studi. 

Sebelum analisis, seluruh parameter dominan dikonversi dari format 

raster ke ASCII menggunakan Raster to ASCII pada ArcGIS. Data yang 

digunakan adalah hasil raster setelah proses Lookup namun sebelum 

dikonversi ke bilangan bulat. Bagian metadata (ncols, nrows, xllcorner, dll.) 

dihapus agar tersisa matriks nilai piksel. Nilai -9999 yang 

merepresentasikan NoData dikeluarkan dari analisis. Dengan demikian, 

setiap baris pada tabel merepresentasikan satu piksel, sedangkan setiap 

kolom mewakili parameter dominan. 

Data pelatihan gerakan tanah (ls_trn.tif) diproses dengan cara yang 

sama, di mana nilai 0 menunjukkan area tanpa gerakan tanah dan nilai 1 

menunjukkan lokasi gerakan tanah. Data ini digunakan sebagai variabel 

dependen. Seluruh file ASCII kemudian diimpor ke IBM SPSS Statistics 23 

melalui File > Open > Data. Opsi A specific number of variables represents 

a case diatur ke angka 1 agar setiap baris dianggap sebagai satu observasi. 

Setelah data berhasil diimpor, kolom diberi nama sesuai parameter 

(misalnya Elevasi, Slope), lalu digabungkan dengan variabel target 

menggunakan Data > Merge Files > Add Variables. Analisis regresi 

logistik biner dilakukan melalui Analyze > Regression > Binary Logistic, 

dengan kolom gerakan tanah sebagai variabel dependen dan seluruh 

parameter dominan sebagai covariates. Pada menu Options, dipilih 

Classification plots, Correlations of estimates, dan Iteration history untuk 

menampilkan hasil tambahan analisis. Setiap parameter diuji dalam model 

untuk menghasilkan nilai koefisien (B), signifikansi (Sig.), dan odds ratio 

(Exp(B)). Hasil akhir ditampilkan dalam tabel Variables in the Equation. 
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Gambar 3.11 Tampilan Hasil Pengolahan Logistic Regression di SPSS 

Perhitungan Landslide Susceptibility Index (LSI) dilakukan 

berdasarkan Persamaan 2.9 dengan formula sebagai berikut. 

Z = -14.511901 + (0.000586 × aspek lereng) +  

(0.000036 × elevasi) + (0.000271 × hujan) +  

(0.000010 × jalan) + (0.000380 × kemiringan lereng) +  

(0.000537 × litologi) + (0.000266 × PGA) + (0.001198 × tanah) + 

(-0.000663 × Tata Guna Lahan)                        (2.9) 

Semua parameter yang telah melalui tahap pengolahan sebelumnya 

dimasukkan ke dalam formula Z sesuai dengan nilai koefisien yang 

diperoleh dari hasil analisis di SPSS. Proses ini menghasilkan raster 

Landslide Susceptibility Index (LSI), yaitu peta nilai kerentanan yang 

menggambarkan kemungkinan terjadinya gerakan tanah pada setiap piksel. 

Tahap perhitungan formula Z dilakukan menggunakan Raster Calculator. 

Hasil akhir dari proses ini berupa raster peta kerentanan gerakan 

tanah berdasarkan metode kombinasi Frequency Ratio dan Logistic 

Regression. Model tersebut dibangun dari integrasi parameter dominan hasil 

analisis FR. Selanjutnya, raster peta yang dihasilkan diklasifikasikan 

menggunakan Tool Reclassify dengan metode klasifikasi Natural Breaks 
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(Jenks) untuk membagi nilai indeks kerentanan ke dalam kelas-kelas 

tertentu. 

3.6.1 Validasi Model Logistic Regression (LR) 

Peta hasil perhitungan Logistic Regression berdasarkan parameter 

dominan terlebih dahulu dikonversi ke format ASCII menggunakan Tool 

Raster to ASCII. Tahap ini dilakukan agar data peta dapat diimpor ke dalam 

IBM SPSS Statistics dalam bentuk tabular numerik. Setelah data ASCII 

diimpor, setiap kolom diberi nama, salah satunya LR_N yang 

merepresentasikan nilai indeks kerentanan pada tiap piksel hasil model LR. 

Selain itu, data raster kejadian gerakan tanah yang digunakan untuk 

pelatihan (ls_trn) dan validasi (ls_tst) juga melalui proses konversi ke 

format ASCII, kemudian dimasukkan ke dalam SPSS. File ls_trn digunakan 

dalam perhitungan success rate, sedangkan file ls_tst dipakai untuk 

menghitung prediction rate dari model Logistic Regression.  

Tahap validasi dilakukan dengan pendekatan Receiver Operating 

Characteristic (ROC) melalui menu Analyze > Classify > ROC Curve di 

SPSS. Pada pengaturannya, kolom LR_N dimasukkan sebagai Test 

Variable untuk mewakili nilai probabilitas kerentanan, sedangkan kolom 

trn atau tst dimasukkan sebagai State Variable untuk menunjukkan 

keberadaan kejadian gerakan tanah. Nilai State Value diisi dengan angka 1 

untuk menandai piksel yang mengalami longsor, sementara piksel tanpa 

kejadian diberi nilai 0. Selain itu, opsi ROC Curve dan With Diagonal 

Reference Line diaktifkan agar SPSS menampilkan grafik ROC lengkap 

dengan garis diagonal sebagai pembanding. Garis diagonal berfungsi 

sebagai acuan pembanding prediksi acak, sehingga interpretasi nilai AUC 

lebih jelas. 


